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The future of Career & Work
• The World is Changing, Workforces 

are Changing.

• Industry 4.0, AI and IoT are calling 
for a new Partnership between 
Humans and Machine

• How are you coping with it?
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Workforce of the future
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Are You ready?

The world is changing

August 2017
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2017: In an Internet minute… 
This image cannot currently be displayed.
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Digital decade

2007

Apple launched 
iPhone

Facebook 
became 
mainstream

2008

Airbnb 
launched

Lehman 
Brothers filed 
for bankruptcy

2009

Launch of Uber

Urban dwellers 
became majority 
of earth’s 
population 

Google 
prototype of 
driverless car

2010

China overtook 
US as largest 
manufacturing 
nation

2006

Launch of 
Twitter

Google became 
a verb

2011

Global 
population 
passed 7 billion

Borders 
bookstores shut 
up shop

Presenter
Presentation Notes
It’s amazing to think about the ways the last decade has changed our lives… how we work, how we liveIn the world “BG” (before Google) knowledge was power – that “content” was locked up in heads and books and hard to accessGoogle launched in 1998 (actually closer to nearly 2 decades ago) in just 2 years it became the world’s biggest search engine - but in 2006 it became a verb - we “Googled”, we didn’t search the internet anymoreFacebook launched in 2004 at Harvard - by 2007 it had stomped MySpace into the ground2007 also brought us the iphone - and it quickly put a nail in the coffin of Psion and it’s Palm Pilot (who remembers them now!) and caused the slow death of Nokia, Motorola and Blackberry as dominant forces in the handset market.At the start of the decade - Borders bookstores didn’t realise it was signing it’s own death warrant either when it handed over its e-commerce business to Amazon - they shut up shop for good in 2011The first half of the Digital Decade is very much characterised as a “battle for the customer interface”
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Digital decade

2012

Kodak files for 
bankruptcy

2013

More
mobile devices
and connections 
than people on
the earth

Blockbuster 
closed for good

2014

64 billion 
WhatsApp 
messages 
sent in a 
single day

2015

Amazon and 
Alibaba rule 
e-commerce

2016

Personal data, 
psychology and 
bots influence 
voting in 
elections

Google’s 
DeepMind 
beats ‘Go’ 
champion

2017

Facebook goes 
to war on ‘Fake 
news’

314 million 
search results 
for ‘Future of 
work’

Presenter
Presentation Notes
And Kodak, the original inventor of the Digital Camera back in 1975 chose not to cannibalize its own business until it was too late - and it finally lost the race in 2012Jump forward to 2016 - digital is doing amazing (and scary) thingsAnyone with an interest in the recent US elections will have seen the debate about the use of personal data, psychology and social media ‘bots’ to try to influence voting patterns. This is the way elections work nowadays.That’s pretty scary stuff - but so is the 2016 “win” by Google’s DeepMind AlphaGo (programmed by Google engineers in the UK) against the world champion of ‘Go’.  Go, a 2,500 year old game , which is said to be the most complex game ever invented. Using a vast collection of Go moves from expert players—about 30 million moves in total—DeepMind researchers trained their system to play Go on its own. But this was merely a first step. In theory, such training only produces a system as good as the best humans. To beat the best, the researchers then matched their system against itself. This allowed them to generate a new collection of moves they could then use to train a new AI player that could top a grandmaster.Basically,  it used machine-learning techniques to teach itself how to win.-------------------Those things we now take for granted have changed our world – in only one decade. Sweeping away the old ways. We need to embrace the disruption and innovateTake Netflix….Blockbuster dominated the storefront video rental business - then Netflix came along with DVDs by post (remember that? In fact they only shut that service in August 2017)But then Netflix quickly realised it needed to disrupt its own business by moving to streaming - but was in a poor bargaining position for content.  To make the change they needed to start creating their own content like House of Cards.To support this change - Netflix had to really think about the workplace culture it wanted to promote - back in 2009 it published a ground-breaking deck which explained in detail exactly how Neflix wanted its workplace culture to develop
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Personal shifts
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Industry 4.0 Revolution 
The Economy of  Things
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History on the move…

Industrial Revolutions…
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Industrial Evolution

4. Industrial 
revolution
Based on cyber-
physical-
systems

3. Industrial revolution 
Through the use of electronics
and IT further progression in
autonomous production

2. Industrial revolution 
Introducing mass production 
lines powered by electric 
energy

1. Industrial revolution
Introducing mechanical 
production machines powered
by water and steam

End of the 
18th century.

Beginning of the 
20th century

Beginning of the 
70th

Industry 1.0 Industry 3.0Industry 2.0 Industry 4.0
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l o
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pl
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ity

Today
Source: DFKI/Bauer IAO



PwC

Cyprus in pre
industrial period
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Cyprus in the industrial Era!

CyI HPC
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Building blocks of Industry 4.0

Industry 4.0

Autonomo
us Robots

Simulation

Horizontal 
and 

vertical 
system 

integration

Industrial 
Internet of 

Things
Cyber 

Security

Additive 
Mfg

Augmented 
reality

Big data 
analytics
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Impact of Industry 4.0

Economy

Business

National 
& GlobalSociety

Individual

Impact

Presenter
Presentation Notes
It is possible to apply this template to exiting presentations.Have the latest presentation template openClick on the View tab and select Normal Delete all unwanted slidesClick on the Insert tab from the menu bar and select Slides from FilesClick on Browse. Navigate to the presentation you wish to update with the new template. Highlight the presentation and click Open Wait for the slides from the presentation to load and click on Insert All. Then click CloseCheck the inserted slides to ensure that the most appropriate master slide has been used on each slide To change the master applied to a slide select the slide you wish to apply a different master to then click on the Format tab from the menu bar and select Slide DesignFrom the Used in This Presentation section choose the master you wish to apply to the slide and hover over it to reveal a drop-down arrow. Click on the arrow and select Apply to Selected SlidesIt is important to thoroughly check the presentation to ensure that no further formatting is needed.
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Millennials—as digital natives—bring vital value to a work 
environment in the midst of a digital revolution

50%
USA workforce

75%
Global workforce

By 2020, Millennials will
be roughly 50% of the U.S. 
workforce, and 75% of the 
global workforce by 2030.1

By sheer numbers alone, Millennials have become 
the catalyst for accelerated change in the workplace. 

They are the first wave of digital natives to enter 
the workforce, and this does distinguish them. 

Organizations that have embarked on their own 
transformation urgently need this digital capital. 

2020 2030

Note: 
1 Meister, Jeanne. “Three Reasons You Need To Adopt A Millennial Mindset Regardless of Your Age.” Forbes. October 5, 2012.

Presenter
Presentation Notes
Millennials are digital natives. The fact that they grew up in a digital world is the fundamental distinction between them and Gen X and Baby Boomers. They comprise the largest generation since the Baby Boomers. And, as such, they are having a profound impact on the workplace. According to Forbes, by 2020 they will make up nearly half of the US workforce. Globally – they will reach 75% by 2030. These digital natives are joining the workforce and moving into roles with more responsibility at precisely the time when businesses are going through their own digital transformation and urgently need the digital acuity many Millennials possess. Millennials are not only our current and future employees (and bosses) but they are our current and future customers.  Understanding their personal views will only help us thrive in our businesses.Millennials will be roughly 50% of the USA workforce in 2020 and 75% of the global workforce by 2030. The sheer size of this demographic segment will force organizations to re-think many of their policies and practices such as delivery of training & development, (think mobile and social) vacation time (unlimited and a focus on performance not face time in the office) and commitment to global job rotations early in one’s career.Millennial preferences using the latest social technologies and innovation platforms to communicate and collaborate on-the-job.. For example one of the findings of the Future Workplace Multiple Generations @ Work Survey of 1,189 knowledge workers and 150 managers found that Millennials value the opportunity to share their ideas and creativity at work. In fact, the ability of an employer to provide on-going opportunities to share openly and collaborate came up as the fourth most frequently mentioned criteria for seeking a best of breed employer after; workplace flexibility, compensation and career progression.

http://www.forbes.com/sites/jeannemeister/%202012/10/05/millennialmindse/
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Global megatrends

Shifts in global economic power
Power shifting between developed and developing countries

Resource scarcity and climate change 
Depleted fossil fuels, extreme weather, rising sea levels and water shortages

Rapid urbanisation 
Significant increase in the world’s population moving to live in cities

Technological breakthroughs
Rapid advances in technological innovation

Demographic shifts 
The changing size, distribution and age profile of the world's population

17
Workforce of the future

Presenter
Presentation Notes
Looking forward: The global megatrends will continue to drive change - the “collisions” between these forces bring both opportunities and threats for businesses - and throw up challenges to organsations and they think about the future of work and their talent[ NB - this is a quick run through which doesn’t really highlight urbanisation or sustainability and instead talks about Trust as a collision]TechnologyTechnology will continue to create massive disruption - indeed we predict it will leave little untouched as its abilities are truly felt - automating work and sweeping away whole classes of tasks and jobs .The time it takes to go from breakthrough technology to mass market application keeps shortening, And the cost of using that technology is dropping all the time - in many cases becoming FREEWe can already see, for instance, a chatbot devised by a student helping New York drivers send legal letters to avoid parking charges FOR FREEThis is reshaping the economy and expectations of buyers for what they will pay for.In the future, with artificial intelligence and cognitive computing – clients certainly won’t pay for  pay for technical knowledge – this will become a “freemium” servicesToday technology is augmenting humans - in the future it will be humans who provide augmentation to work done primarily by technology.BUT…. don’t forget -  the introduction of spreadsheet didn’t kill the accountantThe ATM actually resulted in more banking clerks than ever - but doing very different things - and Financial Services is already being disrupted again with the rapid rise of the RoboAdvisor - leaving human beings focussed on customer“hand holding”-  and of course deciding how technology can be usedSimilarly, as US manufacturing jobs have reduced so manufacturing output has doubled over the last 2 decades - mechanised manufacturing has created the productivity boostThis means opportunities to….Use technology to make better business decisionsFreeing up capacity to make more, higher value interactions with clients.A final thought for now on Technology advancement - in the 1790s 90% of the world population worked in Agriculture - there were less people in the world, but almost all of human effort was focussed on feeding and clothing us.  And if you had told a farmer in 1900 US that with a 95% reduction in farm employment there would not be a shortage of food – he would have looked at you in total disbelief.Demographic ChangeDemographic change with its longer lives and ageing workforces is giving us new career paths and different aspirations of workers. We’ll add another billion people to the world’s population by 2025, making the total 8 billion. At the same time, we’re living longer and having fewer children. As a result, the fastest growing segment of the population will be the over 65s.The millennials (the biggest generation in the workforce) are here now and GenZ are coming[ NB - there is more on demographics and workforce changes later in the presentation ]Rise of the EastContinuing economic rise of the East and a rapid evolution of the business landscape there bringing new opportunities and new global competitors.By 2030, we estimate that the E7’s purchasing power will overtake that of the G7. As incomes rise in these markets, they will contribute an increasing share of the global middle class. In 2015, the middle class in Asia Pacific became larger than that of Europe and North America combined.International firms need to work out how to provide their clients with coverage in these markets.Where the megatrends collideAnd a narrow path is to be trod around public opinion.  The world has never been as transparent. It’s a “radical transparency” driven by social media - it creates public outrage easily and sets today’s actions against tomorrow’s expectations.We see the Government starting to rumble into action on Pay Fairness Overall: Important to realise there are different views amongst professionals, writers, academics etc on pace & spread of disruption but all parties agree that there will be disruption to many jobs/companies. 
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A new balance.
Automation will not only alter the types of jobs 
available but their number and perceived value. 

Pivotal talent – the ultimate prize.
Those workers performing tasks which automation 
can’t yet crack, become more pivotal – and this 
means creativity, innovation, imagination, and 
design skills will be prioritised by employers.

Adaptability – the key to the future.
One clear lesson arises from our analysis: 
adaptability – in organisations, individuals and 
society – is essential for navigating the changes 
ahead.

CEOs agree.
Human talent is a top 3 business issue for CEOs

What does it all mean for jobs?

18
August 2017Workforce of the future

Presenter
Presentation Notes
New balance – not just re-balancing the volumes of workers with different skills – BUT also creates a change in the value and reward of those workersFindings from our most recent survey of 1,400 CEOs around the world share these views …. They say that Human talent is a top 3 business imperative… and [ continues on next slide ]
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What CEOs are saying…

52%

of CEOs plan to 
increase headcount in 
the coming 12 months.

52%

say they’re already 
exploring the benefits of 
humans and machines 
working together

77%
of CEOs find it difficult 
to get the creativity and 
innovation skills they 
need.

60%

of CEOs are rethinking 
the HR function

PwC’s 20th CEO Survey of 1,379 CEOs in 79 countries
19
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Presenter
Presentation Notes
CEOs say
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What CEOs are saying…
• CEOs still need people

• 77% are worried about key skills

• Very human skills top of the list

• 58% are concerned about the impact 
of automation on trust

• 1 in 8 is reducing headcount due to 
automation

20
August 2017Workforce of the future
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Workforces are changing.
How are you planning for the 
Future

21
Workforce of the future
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Workforces are changing

Purpose
Talent mix

Soft skills

Gl
ob
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Work/life
Flexibility

Ageing
Ge

ne
ra

tio
ns
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ot
s

Diversity
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Presenter
Presentation Notes
Workforces - and their expectations of work - are rapidly changing….A desire for Purpose - why do people become [ lawyers ]? Why will they work in the [ legal industry ] in the future?Older Workforce – the 100 year life, age discrimination legislation and the poor performance of pensions, means that we will have people who need to work well into their 70’s.Multiple generations, working together. A changing talent mix of employees, outsourcing, contingent and flexible workers is emerging.Gig talent: We see organisations [ like yours and ours ] starting to juggle with ‘Gig’ talent through online sourcing and management of contingent workers, and… [ eg in Law firms Document review outsourced to companies that hire lawyers on demand instead of partner path talent – reducing costs ]Today’s skills battleground is for soft skills - creativity and innovation, leadership, Adaptability and problem solving - technical skills alone are not enough for today’s work.Diversity & inclusion - a key part of today’s Employer Brand, but also key to driving innovation and is a clearly expected element to choosing a client engagement team in modern professional services.A global talent market – as the world becomes more accessible the best and brightest talent are prepared to follow their own agenda and opportunities, and want to be offered more overseas opportunitiesPeople have less loyalty toward their organisation, and move around to boost their opportunities and experienceExpectation of a better work/life balance and more flexibility over hours and locationsBrains+Bots in collaborationIn an automated world - We already talked about the fact that jobs and careers are evolving and becoming extinctNew jobs are here that didn’t exist a decade or so ago - app developer, bitmoji designer, e-discovery lecturer.But remember, Automating tasks make other human elements in the chain of expertise more important – technology magnifies our leverage, our judgement & creativity instead of replacing it…. For nowIn your business - make sure you know where the repeatable activity is and your options to automate it at the very least.
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AI & Cognitive systems are creating a new partnership 
between humans and technology

Humans 
excel at

DILEMMAS

COMPASSION

DREAMING

ABSTRACTION

IMAGINATION

MORALS

GENERALIZATION

Cognitive Systems
excel at

COMMON SENSE (but with many biases)

ELIMINATING BIASES

LOCATING KNOWLEDGE

PATTERN IDENTIFICATION

MACHINE LEARNING

NATURAL LANGUAGE PROCESSING AT SCALE

PROVIDING ENDLESS CAPACITY
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Artificial intelligence
Assisted Intelligence
Today

• Automating repetitive, standardised 
or time-consuming tasks and 
providing assisted intelligence.

• Increased demand for STEM skills 
to build new tech ecosystem.

24
August 2017Workforce of the future
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Artificial intelligence
Augmented Intelligence
Emerging

• Fundamentally change in the nature 
of work.  Humans and machines 
collaborate to make decisions.

• Uniquely human traits (emotional 
intelligence, creativity, persuasion, 
innovation) become more valuable.

25
August 2017Workforce of the future
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Artificial intelligence
Autonomous Intelligence
Future

• Adaptive continuous intelligent 
systems take over decision making.

• The future of humans at work is 
questioned.

26
August 2017Workforce of the future
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Where do we need humans in an AI world?

Making AI work
• Developing
• Training and testing
• Assuring and explaining
• Sustaining
• Identify and explain new 

uses for AI

Augmenting AI
• Human face of technology
• Providing leadership
• Persuading
• Creativity and innovation
• Using empathy
• Sense checking

Going where AI isn’t
• Uneconomic-to-automate 

niches
• Unpredictable manual tasks
• Artists, artisans and 

craftspeople
• Where human service is 

already chosen over tech

e.g. A financial services 
organisation rolling out new 
robo-adviser

e.g. High-touch customer 
experience – making 
technology human

e.g. Personal trainer, dry-stone 
wall builder, organic baker

27
Workforce of the future

Presenter
Presentation Notes
Making AI workEg Trainers might…. Teach AI systems to look beyond the literal meaning of a communication by, for example, detecting sarcasmExplainers might… AI usefulness strategist: Determines whether to deploy AI (versus traditional rules engines and scripts) for specific applications.Sustainers might… “Promotes” algorithms that perform well to greater scale in the business and “demotes” algorithms with poor performance.Automation ethicist: Evaluates the noneconomic impact of smart machines, both the upside and downside.Automation economist: Evaluates the cost of poor machine performance.Augmenting AIWhere humans work to supplement the AI’s capabilities Eg – Robo Advisor technology in a bank can give arguably better financial advice – but does it understand the human context and complexity? – the calculations say long term investments suit a husband and wife – but a human could sense that they will be getting divorced soon!!!Finally, going where AI isn’t …. YETThis falls into 2 sub categoriesSome things are unecomonic to automate or nicheOrWhere humanness is valued or actively chosenEg – the AI in your smartphone can provide almost all the help a personal trainer can give you – but will it give you the same motivation as another human’s disappointment?
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What will the AI/human mix look like 
in your Future?

29
August 2017Workforce of the future



PwC Digital Services 30

Workforce Domains
The BXT Equation

Balanced and 
Holistic

Skills, Capabilities, 
Competencies

PwC Digital Services

Business
Strategy, operations, analytics, tax, risk capabilities and industry 

expertise, applied to solve a wide range of business issues – from 
ideas to results

Technology
Technical capabilities in the field of digital 

and other emerging technologies, to 
assess application potential in a business 

and / or user context

eXperience
UX/UI design capabilities to rethink business 
models and create new value propositions, 
based on thorough understanding of user 

preferences and motives
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“If everything seems under control,
you're not going fast enough.”

31
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Thank You!!!!!
Find out more…

3 August 2017
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This image cannot currently be displayed.

www.pwc.com/futureworkforce
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